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Installing MT4 on a Windows PC 
 
1. Begin installation by downloading the UTRADE MT4 installer: 

https://download.mql5.com/cdn/web/uob.kay.hian/mt4/utradefx4setup.exe 
 

2. Run the installer and follow the installation steps on screen.  
 

3. Read the license agreement to continue the installation.  

 

 
 

 
 

 
 
 
 
 
 
 
 

https://download.mql5.com/cdn/web/uob.kay.hian/mt4/utradefx4setup.exe
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Installing MT4 on Mac operating system 

 
Installation of MT4 on Mac systems is a complicated process. 
 
MetaQuotes has detailed instructions to install it manually here:  
https://www.mql5.com/en/articles/1356 

 
 
System Requirements  
 
MT4 is a desktop application available only for Windows. While there are Linux installations, 
they require a lot of work to install and are not recommended.  
 
System requirements for MT4 are low. The platform is designed to use very limited system 
resources.  
 
Minimum requirements: 
Operation system: Windows 7/10 
Processor: 1.5 GHZ 
RAM: 1 GB 
Screen resolution: 1024x768 
1.5 Mbps broadband internet connection  
 
Recommended requirements: 
Operation system: Windows 7/10 
Processor: 2GHZ or higher 
RAM: 2 GB or more 
Screen resolution: 1280x1024 or higher 
8 Mbps broadband internet connection  
 

 
 

https://www.mql5.com/en/articles/1356
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Launching MT4 and Initial Login  

 
Upon successful installation, the UTRADE MT4 Terminal will appear on your desktop: 
 

 
 
Double-clicking on the UTRADE MT4 Terminal icon will launch the MT4 trading platform. 
 
The default MT4 platform layout is shown below when it is launched for the first time. The 
platform is only partially functional until logging into either a demo or live server.  
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Once the application launches, you will be prompted to enter your login details and password. 

 

 
 
1. Enter the Login (username) and Password 
2. Enter and select the correct server as follows: 

DEMO SERVER: UtradeFX-Demo 
LIVE SERVER: UtradeFX-Live 

3. Click Save account information if needed.  
WARNING: This option should not be used on public computers. 

4. Click Login  
 
Upon successful login, the platform will make a positive ‘chime’ sound effect.  
 
On the bottom right of the platform, the Connection Status will be half red and half green 
and will show the transfer/connection speed (e.g. 10300/2 kb). 
 

 
 
If the login is not successful, it will show No connection or Invalid account  
 

 
 
If connection is fully red and shows No connection, please check the following: 
 

 Check your internet connection. If using Wi-Fi, please try reverting to a physical 
connection. 

 Ensure you have selected the correct server. 

 We may be performing maintenance. 
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If connection is fully red and shows Invalid account, please check the following: 
 

 Check that you have selected the correct server. 

 Make sure each field is completely empty before you type your credentials. 

 Ensure your login details are correct. 

 Do not copy and paste the password. Always enter them MANUALLY. 

 

 
 
If connection is fully red and shows Account disabled, contact UOB Kay Hian Client 
Services for support at the following email: alternativeproducts@utrade.com.sg or call us at 
+65 6536 9338. 

 
 
Changing Password 
 
It is highly recommended that you change your password upon logging into the platform for 
the first time. 
 
To change your password, go to Tools > Options > Server tab > Change button (next to the 
Password field).  

 

 
 

mailto:alternativeproducts@utrade.com.sg


UTRADE FX – MT4 USER GUIDE 

 

7 

Enter the Current password first, then select the radio button Change master password 
and then enter your preferred password. 

 

 
 
Setting an Investor Password 
 
This allows a client to set a view-only password on their MT4 account. They can then give this 
password (along with their login/username) to third parties so that they can login and view the 
account but not trade. 
 
To set the investor password, go to Tools > Options > Server tab > Change button (next to 
the password field). Enter the Current password first, then select the radio button Change 
investor (read only) password and then enter the preferred password. 
 
 

Forgot your Password? 
 
If you have forgotten your password, kindly email our Client Services at the following email: 
alternativeproducts@utrade.com.sg or call us at +65 6536 9338 to reset your password.  
 
 

MT4 on iPhone and Android  
 
Please download the “MetaTrader 4” app from the App Store or  Play Store and select the 
UTRADE FX server. 
 
 

 
 
 
 
 

 
 
 

mailto:alternativeproducts@utrade.com.sg
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MT4 PLATFORM OVERVIEW 
 
The MT4 platform is relatively intuitive and easy to use and navigate. A right-click on any part 
of the platform will bring up sub-menus for you to perform most trading functions where 
needed.  
 
The following are main areas of the MT4 platform:  

 
Main Menu 
 

 
 
The main menu of the terminal is located under the program heading and represents a set of 
sub-menus. 
 

File: Working with charts, storing of historical data and profiles, and print. 

View: Setting toolbar, managing command windows ("Market Watch", "Data Window", 
"Navigator", "Terminal", "Tester") and the program interface language. 

Insert: Managing technical indicators, line studies, and other objects. 

Charts: Setting of bars display, scale, managing imposed objects, presence of grid, chart 
properties. 

Tools: General settings of the client terminal, History Center, global variables, and 
MetaEditor (MetaQuotes Language 4 editor). 

Window: The list of open charts and their locations. 

Help: User guide and information about the program. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_file
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_view
http://www.metatrader4.com/en/trading-platform/help/overview/market_watch
http://www.metatrader4.com/en/trading-platform/help/overview/data_window
http://www.metatrader4.com/en/trading-platform/help/overview/navigator
http://www.metatrader4.com/en/trading-platform/help/overview/terminal
http://www.metatrader4.com/en/trading-platform/help/autotrading/tester
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_insert
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_charts
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_tools
http://www.metatrader4.com/en/trading-platform/help/autotrading/metaeditor
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_window
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_help
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Toolbars 
 

There are four toolbars built into the terminal. The main commands used in the terminal are 
duplicated in the toolbars in form of buttons. Normally, the toolbars are placed under the main 
menu, but they can easily be moved into any program window area. Toolbars can be shown 
or hidden by the "View — Toolbars" menu command. All toolbars are customizable, and allow 
you to place only necessary, often used commands in them. To set up a toolbar, you have to 
open its context menu (right mouse-button click) and execute the "Customize..." command. 

 

All commands are grouped in toolbars according to their functions: 

 Standard — managing general commands of the terminal; 

 Charts — commands for managing charts; 

 Line Studies — managing objects to be imposed onto charts; 

 Timeframes — managing the chart timeframes. 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_view
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_standard
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_charts
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_line_studies
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_periodicity
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Market Watch 
 

The securities (symbols) for which the Client Terminal gets quotes from the server are listed 
in the "Market Watch" window.  

 

The data is represented in this window as a table having several fields. The "Symbol" field 
contains the security name, the fields of "Bid", "Ask", and "Time" show the corresponding 
prices and time of their update from the server. Values of the "Maximum" and "Minimum" 
fields are calculated on basis of price changes within a day. The "Market Watch" window can 
be opened/closed by pressing the keys Ctrl+M, by the "View — Market Watch" menu 

command, or by pressing of the  button of the "Standard" toolbar. 

This window allows you to place market and pending orders and open new charts. Upon the 
right mouse button click in the "Market Watch" window, the context menu will appear where 
the following commands are available: 

•New Order — open the "New Order" window where one can prepare and place a 
market or a pending order for the symbol selected. At the order preparation stage, one 
can specify the Stop Loss and Take Profit levels. The "New Order" window can also be 
opened by double clicking on the security name in the "Market Watch" window, by the 
"Tools — New Order" menu command, by the "Terminal — Trade — New Order" 

window context menu command, the  button of the "Standard" toolbar, or by 
pressing of F9; 

 

•Chart Window — open the chart of the symbol selected. The symbol chart can also be 
opened by the "File — New Chart" and "Window — New Window" menu commands 

and by pressing of the  button of the "Standard" toolbar; 

 

 

 

 

http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_view
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_standard
http://www.metatrader4.com/en/trading-platform/help/positions/orders
http://www.metatrader4.com/en/trading-platform/help/positions/orders
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_tools
http://www.metatrader4.com/en/trading-platform/help/overview/terminal
http://www.metatrader4.com/en/trading-platform/help/overview/terminal
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_standard
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_file
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_window
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_standard
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•Tick Chart — open the tick chart of the symbol selected. Unlike normal charts, the tick 
chart is located directly in the "Market Watch" window. The tick chart of the selected 
symbol can also be viewed by switching to the tab of the same name in the same 
window. The tick data loads only when the account is connected. Thus, if an account 
has not been active for a certain period of time, the tick chart may appear empty in the 
beginning. The tick data is stored separately for each server; 

 

•Depth Of Market — open the depth of market of the symbol selected; 

 

•Specification — open symbol parameters; 

 

•Hide — delete (hide) the symbol from the list. To minimize traffic, it is recommended to 
hide unused securities from the quotes window by this command or by pressing the 
Delete button. 

 

Attention: If there are open positions or pending orders for the symbol, or its chart is open, the 
symbol cannot be deleted. 

 

•Hide All — delete all symbols from the list. This command does not apply to securities 
for which there are open positions or the charts of which were opened in the current 
working session; 

 

•Show All — show the list of all available securities. After this command has been 
executed, quotes will load for all these symbols; 

 

•Symbols — call the window of the same name where there is a list of all available 
symbols. Symbols are grouped in the window according to their types. The "Show 
Symbol" command allows you to add necessary symbols to the quotes window, and 
that of "Hide Symbol" — to delete a symbol from it. The "Properties" window command 
allows you to view the symbol parameters; 

 

•Sets — open the sub-menu that manages the symbol sets. The current set of symbols 
can be stored in this sub-menu, as well as delete or select an existing one. This is very 
convenient when working with securities of different types; 

 

•Spread — show/hide column that displays spread — the difference between the bid 
and ask prices; 

 

•High/Low — add the highest and the lowest values of the daily price to the quotes 
displayed; 

 

•Time — show time of incoming quotes; 

 

•Auto Arrange — automatic arrangement of columns when changing the window size. 
Auto Arrange can also be enabled by pressing the A button; 

 

•Grid — show/hide the grid separating columns. The grid can also be shown by 
pressing the G button; 

http://www.metatrader4.com/en/trading-platform/help/overview/depth_of_market
http://www.metatrader4.com/en/trading-platform/help/overview/market_watch#specification
http://www.metatrader4.com/en/trading-platform/help/positions
http://www.metatrader4.com/en/trading-platform/help/positions/orders
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•Popup Prices — open an additional quotes window. You can also open this window by 
pressing F10 on your keyboard. The list of symbols in this window is the same as that in 
the "Market Watch" window at the moment of the command execution. This means that 
changes in the symbol list in the "Market Watch" window does not influence that in the 
"Popup Prices". It is an information window, but trading operations can also be 
performed from it. To do so, you have to double-click with the left mouse button on the 
desired security. In the context menu of this window, there are commands allowing you 
to set up data displaying parameters, enable the full screen mode, or place the window 
over all others. 
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Data Window  
 

This window is intended for displaying of price information (OHLC), date and time of the bar, 
and the indicators (including custom ones) used. "Data Window" is an information window 
and it does not allow you to perform any actions. The desired information about a certain bar 
and the imposed indicators can be obtained here promptly. To do so, it is sufficient to place 
the cursor over the necessary bar. 

 

Context menu commands of this window allow: 

Copy — copy data from this window into the clipboard for further use in other applications. 
The same action can be performed by pressing of accelerating keys of Ctrl+C; 

 

Last Data — show/hide the latest data column. An additional column containing the last 
bar data will appear in the window; 

 

Auto Arrange — set up the column size automatically when the window size changes; 

 

Grid — show/hide grid to separate columns; 

 

Show — show/hide information fields. Any of the bar prices (OHLC), date or volume can 
be selected in the sub-menu that appears. If the element has not been checked, it will not 
be shown. 
 
 

http://www.metatrader4.com/en/trading-platform/help/analytics/tech_indicators
http://www.metatrader4.com/en/trading-platform/help/autotrading/custom_indicators
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Navigator 
 
The navigator panel is essentially a panel that allows quick access to certain features of the 
platform, such as the ability to switch between accounts, add indicators & custom indicators to 
a chart, manage EA’s and scripts.  
 
This window can be opened/closed by pressing accelerating keys of Ctrl+N, by the "View — 

Navigator" menu command, or by pressing the  button of the "Standard" toolbar. 
 

 
 
 
This panel can be customized by adding favorites to the Favorites tab. Right-click on an item 
in the Navigator panel (for example an indicator) and then click Add to Favorites. 
 

http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_view
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_view
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_standard
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Accounts 

The "Accounts" group includes the list of open accounts. Using a context menu, you can open 
a new demo account or delete the old one. 

 

•Open an Account — An unlimited amount of demo accounts can be opened via the 
terminal. To do so, you have to execute the "Open an Account" context menu command 
or press the Insert button. More details about opening of accounts can be found in the 
corresponding section. 

 

•Login to Trade Account — to authorize an existing account (whether a demo or a real 
one), you have to execute the "Login to Trade Account" command or double-click with 
the left mouse button on the desired account line. 

 

•Login to Web Terminal — the web terminal allows trading on financial markets and 
conducting technical analysis by using a web browser. The web platform is safe to use - 
any transmitted information is securely encrypted. 

 

•At the moment, the web terminal is under testing and not all of its planned features are 
available.  
•Web trading is available at MQL5.community in the "Trading" section. 

 

•Login to MQL5.community — open the settings of the trading platform to login to 
MQL5.community and get additional services. 

 

•Change Password — change the password of the trade account. 

 

•Delete — delete a selected account. The same action can be performed by pressing 
the Delete key. 

 

•Add to Favourites — add the selected account to favourites. 

 

•Register as Signal — register a selected account in the "Signals" service. After 
executing this command, you will be led to the signal registration page at 
MQL5.community. The selected account and the right UOBKH server will automatically 
be specified in the registration form. 

 

 

http://www.metatrader4.com/en/trading-platform/help/userguide/open_an_account
https://www.mql5.com/en/trading
http://www.metatrader4.com/en/trading-platform/help/setup/settings_mql5community
https://www.mql5.com/
http://www.metatrader4.com/en/trading-platform/help/setup/setup_server#passwords
http://www.metatrader4.com/en/trading-platform/help/overview/navigator#favorites
https://www.mql5.com/en/signals
http://www.metatrader4.com/en/trading-platform/help/signals/signal_provider#add
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•Register a virtual server — this command allows you to allocate a virtual server for 
the terminal's continuous round-the-clock operation. Unlike renting ordinary VDS or 
VPS from third-party companies, you are able to select the server that is the closest to 
UOBKH minimizing the network latency when sending orders from the terminal to the 
trade server. 

 

Attention: Real accounts cannot be started from the terminal, they can only be opened by 
UOBKH. 

 
Indicators 

This group contains indicators — the main tools for analysing the price dynamics: 

•Built-in technical indicators divided into four categories: Trend, Oscillators, Volumes, 
Bill Williams. 

 

•Indicators downloaded from the source code library at MQL5.community. Displayed in 
the Downloads sub-category. 

 

•Indicators purchased from the Market — the store of applications for the trading 
platform. Displayed in the Market sub-category. 

 

•Built-in examples of indicators with the source codes. Displayed in the Examples sub-
category. 

 

•Custom indicators located in /MQL4/Indicators folder; displayed according to the 
structure of sub-folders they are stored in. 

 

The Navigator shows executable indicator files (*.EX4) only. 

If the diamond in the lower right corner of a program icon is gray (for example, ), it means 
that the program does not have the source code files or that they cannot be compiled. 

 

http://www.metatrader4.com/en/trading-platform/help/virtual_hosting
http://www.metatrader4.com/en/trading-platform/help/analytics/tech_indicators
http://www.metatrader4.com/en/trading-platform/help/overview/terminal/toolbox_codebase
http://www.metatrader4.com/en/trading-platform/help/overview/terminal/toolbox_market
http://www.metatrader4.com/en/trading-platform/help/autotrading/custom_indicators
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The following commands can be executed in the context menu: 

•Attach to Chart — apply a selected indicator to the active chart. The same action can 
be performed by a double click on the indicator. You can also apply an analytical tool to 
any chart or a subwindow of already attached indicator by using the Drag'n'Drop 
method. 

 

•Modify — open the source code file (*.MQ4) of a selected indicator in MetaEditor. The 
same action can be performed by selecting an indicator and pressing the Enter key. 

 

•Delete — delete a selected custom indicator. This action deletes both its executable 
file (*.EX4) and its source code file (*.MQ4). The same action can be performed by 
clicking the Delete key. 

 

•Buy from the Market — go to the Market — the store of applications for the trading 
platform. 

 

•Order your own Program — place an order for the development of an MQL4 program 
at the "Freelance" service at MQL5.community. 

 

•Create in MetaEditor — create a custom indicator. The execution of this command 
opens MQL4 Wizard in MetaEditor where an indicator can be created. The same action 
can be performed by clicking the Insert key. 

 

•Add to Favorites — add a selected indicator to favorites. 

 

•Set hotkey — assign a hotkey to the selected indicator. 

 

•Refresh — retrieve information about existing compiled indicators from the hard disk. 
The execution of this command is necessary when copying already compiled files to the 
corresponding folder of the client terminal. 

 

•Online library — go to the "Code Base" section, where you can easily download 
programs published in the corresponding section of the MQL5.community website. 

 
Expert Advisor 

The "Expert Advisors" group contains the list of all available expert advisors. Expert Advisors 
in the terminal are programs allowing you to automate analytical and trading activities. To 
create and modify them, the built-in editor, MetaEditor, is used. More details about creation 
and working with experts can be found in the "Auto Trading" section. 

The "Create" context menu command allows you to create a new expert, "Modify" — to 
modify an existing one, and "Delete" — to delete an expert from the terminal. The "Attach to a 
Chart" command or double-click with the left mouse button allows you to impose the expert 
onto the active chart. Thereafter, when a new tick loads, the expert will start working. Experts 
can be imposed onto any chart with the "Drag'n'Drop" technique.  

 
 
 
 

http://www.metatrader4.com/en/trading-platform/help/autotrading/metaeditor
http://www.metatrader4.com/en/trading-platform/help/overview/terminal/toolbox_market
https://www.mql5.com/en/job
http://www.metatrader4.com/en/trading-platform/help/autotrading/metaeditor
http://www.metatrader4.com/en/trading-platform/help/overview/navigator#favorites
http://www.metatrader4.com/en/trading-platform/help/overview/navigator#favorites
https://www.mql5.com/en/code
http://www.metatrader4.com/en/trading-platform/help/autotrading/experts
http://www.metatrader4.com/en/trading-platform/help/autotrading/metaeditor
http://www.metatrader4.com/en/trading-platform/help/autotrading
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Terminal 
 
"Terminal" is a multifunctional window granting you access to various terminal features. This 
window gives you control over trading activities, view news and account history, set up alerts, 
and work with the internal mail and system journal. The window can be opened by the "View 

— Terminals" menu command, by pressing of accelerating keys of Ctrl+T, or the  button of 
the "Standard" toolbar. There are 10 tabs in the window: 
 

 
 
 
 Trade: Shows account balances, open trades, pending orders and running P&L. 
 
 Exposure: Shows the summary information about the state of your assets for all open 

positions. 
 
 Account History: Shows a comprehensive list of past trading activity such as 

deposits/withdrawals and closed trades. It does not take into account current open 
positions. 

 
 Alerts: Create and manage alerts. 
 
 Mailbox: A messaging inbox through which clients receive incoming and outgoing 

messages. 
 
 Market: Marketplace to purchase new indicators, EA’s and more. 
 
 Code Base: This tab allows you to access the code base published at MQL4.community 

right from the client terminal. By selecting a necessary MQL4 application at this tab, you 
can download it and attach to the chart right away. 

 
 Experts: This tab contains the entire information about the attached expert, including 

opening/closing of positions, modifying of orders, the expert's own messages, etc. 
 
 Journal: This tab contains information about the stated actions of the trader and the 

client terminal within the current session. 
 
 

http://www.metatrader4.com/en/trading-platform/help/overview/terminal/terminal_trade
http://www.metatrader4.com/en/trading-platform/help/overview/terminal/terminal_news
http://www.metatrader4.com/en/trading-platform/help/overview/terminal/terminal_account_history
http://www.metatrader4.com/en/trading-platform/help/overview/terminal/terminal_alerts
http://www.metatrader4.com/en/trading-platform/help/overview/terminal/terminal_mailbox
http://www.metatrader4.com/en/trading-platform/help/overview/terminal/terminal_journal
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_view
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_view
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_standard
https://www.mql5.com/en/code/mt4
http://www.metatrader4.com/en/trading-platform/help/autotrading/mql4
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Tester  

"Tester" is a multifunctional window that allows you to test strategies and optimize parameters 
of expert advisors. When being tested, the expert is passed through the modelled data 
allowing it to estimate its profitability and effectiveness. For optimization purposes, the 
mechanical trading system is passed many times in order to find such parameters of the 
expert at which its profitability is the highest. 

The window can be called by the "View — Strategy Tester" menu command, by pressing of 

accelerating keys of Ctrl+R, or the  button of the "Standard" toolbar. 

 

There are several tabs in this window: 

•Settings — settings for testing and optimization. The parameters of expert advisors, 
period to be tested, the method of bars modelling, and many other things, can be set up 
in this tab; 

 

•Results — the results of trade operations performed by the expert, as well as the 
direction of balance changes; 

 

•Graph — display of testing results in a graph; 

 

•Report — the detailed testing report. Many indications of testing and effectiveness of 
experts can be found here: the amount of bars modelled, the total profit, the most 
profitable and unprofitable positions, the amount of profit and loss trades, etc.; 

 

•Journal — a log where all actions and internal messages of the expert are recorded; 

 

•Optimization Results — information about every pass, including inputs, profitability, 
drawdowns, and other data; 

 

•Optimization Graph — the results of expert optimization as a graph. Besides each 
pass profitability, the amount of profit and loss trades is also displayed in the graph. 

 

 

http://www.metatrader4.com/en/trading-platform/help/autotrading/tester
http://www.metatrader4.com/en/trading-platform/help/autotrading/tester_optimization
http://www.metatrader4.com/en/trading-platform/help/autotrading/tester_optimization
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_view
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_standard
http://www.metatrader4.com/en/trading-platform/help/overview/strategy_tester/strategy_tester_setup
http://www.metatrader4.com/en/trading-platform/help/overview/strategy_tester/strategy_tester_results
http://www.metatrader4.com/en/trading-platform/help/overview/strategy_tester/strategy_tester_charts
http://www.metatrader4.com/en/trading-platform/help/overview/strategy_tester/strategy_tester_report
http://www.metatrader4.com/en/trading-platform/help/overview/strategy_tester/strategy_tester_journal
http://www.metatrader4.com/en/trading-platform/help/overview/strategy_tester/strategy_tester_opt_results
http://www.metatrader4.com/en/trading-platform/help/overview/strategy_tester/strategy_tester_opt_charts
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As in the "Terminal" window, some tabs of the "Tester" window are hidden if they are empty. 
So, initially, only the tabs of "Settings" and "Journal" can be seen in this window. The tabs of 
"Results", "Graph", and "Report", will only appear after an expert has been tested. After it has 
also been optimized, the tabs of "Optimization Results" and "Optimization Graph" will appear. 
More detailed information about testing experts can be found in the section of the same 
name. 

 
 

http://www.metatrader4.com/en/trading-platform/help/overview/terminal
http://www.metatrader4.com/en/trading-platform/help/overview/strategy_tester/strategy_tester_setup
http://www.metatrader4.com/en/trading-platform/help/overview/strategy_tester/strategy_tester_journal
http://www.metatrader4.com/en/trading-platform/help/overview/strategy_tester/strategy_tester_results
http://www.metatrader4.com/en/trading-platform/help/overview/strategy_tester/strategy_tester_charts
http://www.metatrader4.com/en/trading-platform/help/overview/strategy_tester/strategy_tester_report
http://www.metatrader4.com/en/trading-platform/help/overview/strategy_tester/strategy_tester_opt_results
http://www.metatrader4.com/en/trading-platform/help/overview/strategy_tester/strategy_tester_opt_charts
http://www.metatrader4.com/en/trading-platform/help/autotrading/tester
http://www.metatrader4.com/en/trading-platform/help/autotrading/tester
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Charts 
 
A focal point of the platform, covered in detail in a later section. However, an important thing 
to note with charts is the fact that a lot of functions in MT4 will occur on the active chart only. 
For example, if you press the +New Order button on the Standard toolbar, the market/symbol 
on the order window will be selected based on the active chart.  
 
The active chart is the chart that is ‘selected’. If you have multiple charts open, you can select 
one to make it the active chart. The window frame is highlighted as per standard Windows 
functionality.  
 

A chart shows the price changes for a security with time. Charts are necessary for performing 
technical analysis, working of expert advisors and testing thereof. Up to ninety-nine charts 
can be opened in the terminal at the same time. 

The client terminal allows you to: 

•open up to 99 charts simultaneously; 

•set up their representation form and information shown; 

•print charts; 

•impose and delete various objects and indicators; 

•recover deleted charts; 

•use chart templates. 
 
 

http://www.metatrader4.com/en/trading-platform/help/analytics
http://www.metatrader4.com/en/trading-platform/help/autotrading/experts
http://www.metatrader4.com/en/trading-platform/help/autotrading/tester
http://www.metatrader4.com/en/trading-platform/help/chart_management/charts_open
http://www.metatrader4.com/en/trading-platform/help/chart_management/charts_setup
http://www.metatrader4.com/en/trading-platform/help/chart_management/charts_print
http://www.metatrader4.com/en/trading-platform/help/chart_management/charts_control
http://www.metatrader4.com/en/trading-platform/help/chart_management/charts_deleted
http://www.metatrader4.com/en/trading-platform/help/chart_management/templates
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USING CHARTS 
 
Opening charts  
 

 

A new chart can be opened by executing the "File — New Chart" menu command, "Window 

— New Window" menu command, or by pressing of the  button of the "Standard" toolbar. 
The list of securities available will appear when performing any of the above actions. Having 
selected the necessary symbol from this list, you can open its chart. New charts can also be 
opened from the "Market Watch" window, holding Ctrl and dragging the element of the list 
(the symbol) from the window into any point of the workspace of the terminal, or having 
executed the "Chart Window" command of the context menu. All new charts are opened with 
the DEFAULT.TPL template created during the terminal installation. This template cannot be 
deleted, but it can be modified. 

Historical data used for drawing of charts are stored on the hard disk. When opening a chart, 
the data is downloaded from the disk and the last missing data is spooled from the trading 
server. If there is no historical data for the symbol on the hard disk, the last 512 bars of history 
will be downloaded. To spool earlier data, you have to move the chart to the desired area. 
After the chart has been opened, information about current quotes starts to load onto the 
terminal. Thus, further price changes will be shown in the real-time mode. This information will 
be stored in the history file and is used at the reopening of this chart in future. 

 
 
 
 
 
 
 
 
 
 

http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_file
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_window
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_window
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_standard
http://www.metatrader4.com/en/trading-platform/help/overview/market_watch
http://www.metatrader4.com/en/trading-platform/help/chart_management/templates
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Navigating around the chart 
 
Navigating around the chart will take some getting used to if you’re familiar with ITF/IG charts. 
This is because the mouse scroll wheel is used to move back and forward in time, rather than 
zoom. Also, the chart is automatically scaled so that all data is kept within view (this can be 
changed in Tools > Options).  
 
You can also click and drag the chart around to view it. There are also several ways to zoom, 
but the two easiest ways are using the zoom buttons at the top of the chart, or the + and – 
keys on the keyboard.  
 
Chart setup 
 

Appearance and properties of each chart in the terminal can be set up individually. To do so, 
you have to execute the "Charts — Properties..." menu command, the chart context menu 
command of the same name, or press F8. These actions will open the "Properties" window 
that can be used for setting the colour of various elements of the chart (the "Colors") tab: 

•Background — chart background colour; 

•Foreground — colour of axes, scales, OHLC line; 

•Grid — chart grid colour; 

•Bar Up — bar up, shades and fringing of the Bull Candle body; 

•Bar Down — bar down, shades and fringing of the Bear Candle body; 

•Bull candle — colour of the Bull Candle body; 

•Bear candle — colour of the Bear Candle body; 

•Line graph — line chart and doji; 

•Volumes — volumes and levels of open positions; 

•Ask line — colour of the Ask line; 

•Stop levels — levels of stop orders (Stop Loss and Take Profit) 
 

 
 

http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_charts
http://www.metatrader4.com/en/trading-platform/help/positions/orders
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The changes made are automatically shown in the left part of the window in the preview chart. 
Apart from the manual setting of various colour elements of the chart, one can choose pre-
defined colour diagrams in the field of the same name. There are three colour diagrams 
available in the terminal: "Yellow on Black", "Green on Black", and "Black on White". After a 
colour diagram has been chosen, the chart elements described above will change in the chart 
in the left part of the window. Custom colour diagrams can be stored in templates. 

Other chart settings can be defined in this window as well. To do so, you have to switch to the 
"Common" tab and select the desired options: 

•Offline chart — turn the chart offline. This option stops receiving and drawing of price 
data for the given chart. In future, after this option is disabled, price data will be drawn in 
the chart again. After the chart has been opened offline, (the "File — Open offline" 
menu command), this option will be enabled automatically. 

 

•Chart on foreground — place the chart in the "foreground". If this function is enabled, 
all analytical objects will be placed "under" the price chart. This command is the same 
as that of "Charts — Foreground chart". 

 

•Chart shift — shift the chart from the right border of the window to the shift mark. The 
chart shift mark (a gray triangle in the upper part of the window) can be moved with the 
mouse horizontally within 10 to 50% of the window size. This option can also be 

enabled with the  button of the "Charts" toolbar or by the "Charts — Chart Shift" 
menu command. 

 

•Chart autoscroll — allow/forbid the shifting of the chart to the left automatically after 
the new bar has started to form. If this option is enabled, the latest bar will always be 

shown in the chart. This option can also be enabled by the  button of the "Charts" 
toolbar and by the "Charts — Auto Scroll" menu command. 

 

http://www.metatrader4.com/en/trading-platform/help/chart_management/templates
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_file
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_file
http://www.metatrader4.com/en/trading-platform/help/analytics
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_charts
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_charts
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_charts
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_charts
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_charts
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_charts
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_charts
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•Scale fix One to One — fix the chart scale as "one to one" (the size of one pip of the 
vertical axis in pixels is equal to the distance between the bars axes in pixels). The 
"Scale fix" option will be enabled automatically, and a scroll bar will appear at the right 
side of the window that allows you to move the chart vertically. This mode is necessary 
for precise constructions. 

 

•Scale fix — fix the current chart scale. If the scale has not been fixed, the chart will be 
automatically scaled vertically. This option disables automatic scaling and fixes the 
current scale. When this option is selected, the fields of additional scaling parameters 
"Fixed maximum" and "Fixed minimum" are activated. 

 

•Bar chart — display the chart as a sequence of bars. This action can also be 

performed with the  button of the "Charts" toolbar, by the "Charts — Bar Chart" menu 
command or by pressing of accelerating keys of Alt+1. 

 

•Candlesticks — display the chart as a sequence of candlesticks. This action can also 

be performed with the  button of the "Charts" toolbar, by the "Charts — Candlesticks" 
menu command, or by pressing of accelerating keys of Alt+2. 

 

•Line chart — display the chart as a broken line that connects the points of bar close 

prices. This action can also be performed by the  button of the "Charts" toolbar, by 
the "Charts — Line Chart" menu command, or by pressing of accelerating keys of Alt+3. 

 

•Show OHLC — show/hide the OHLC line. If this action is done, an additional data line 
will appear in the upper left part of the window. Apart from symbol name and chart 
period, the latest bar prices are also listed in it. Prices are recorded in the following 
format: OPEN, HIGH, LOW and CLOSE (OHLC) — bar open price, the highest bar 
price, the lowest bar price, and bar close price, respectively. Thus, the precise value of 
the latest bar can always be seen. This option influences the data line of sub-windows 
of indicators, as well. 

 

•Show Ask line — show/hide Ask price level of the latest quote. Bars are drawn and 
shown only on Bid prices in the terminal. However, at opening of long positions and 
closing of the short ones, the Ask price is always used. It is not shown in the chart by 
default, so it cannot be seen. To control one's trading activities more precisely, one can 
enable the "Show Ask line" parameter. After this command has been executed, an 
additional horizontal line will appear in the chart which would correspond with the Ask 
line of the latest bar. 

 

•Show period separators — show/hide period separators. Date and time of each bar 
are displayed on the horizontal axis of the chart. The horizontal scale interval is the 
selected timeframe. The "Show period separators" option draws additional vertical lines 
in the chart that correspond with the larger period (timeframe) borders. Hence, daily 
separators will be drawn for charts with periods of M1 to H1, weekly ones — for H4, 
monthly ones — for D1, and yearly ones — for W1 and MN1. 

 

•Show grid — show/hide grid in the chart window. The same actions can be performed 
by the chart context menu and "Charts" menu command of the same name, as well as 
by pressing of accelerating keys of Ctrl+G. 

 

 

http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_charts
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_charts
http://www.metatrader4.com/en/trading-platform/help/overview/fast_nav#accelerators
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_charts
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_charts
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_charts
http://www.metatrader4.com/en/trading-platform/help/overview/fast_nav#accelerators
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_charts
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_charts
http://www.metatrader4.com/en/trading-platform/help/overview/fast_nav#accelerators
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_charts
http://www.metatrader4.com/en/trading-platform/help/overview/fast_nav#accelerators
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•Show volumes — show/hide the volume chart in the lower part of the window. This 
option does not function when the scale is fixed. The same actions can be performed by 
the chart context menu and "Charts" menu command of the same name, as well as by 
pressing of accelerating keys of Ctrl+L. 

 

•Show object descriptions — show/hide object descriptions in the chart. If this option 
is enabled and there are available descriptions of objects imposed onto the chart, they 
will be shown directly in the chart. 

 
Chart data  
 
MT4 charts the bid-price, NOT the mid-price. Hence, candles are formed using the bid-price. 
You can right-click on a chart and select Properties to also show a horizontal dynamic Ask 
Line. 
 

http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_charts
http://www.metatrader4.com/en/trading-platform/help/overview/fast_nav#accelerators
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Chart Management 
 

Charts allow you to analyze price changes in the market and are used for graphical analysis, 
building of various indicators and line studies. Charts are a very valuable instrument for 
analyzing financial markets, which is why great attention is paid to them. Chart management 
refers to: 

•Chart Type 
A chart can be of three types: 

•Bar Chart — the sequence of bars. 

To enable a chart of this type, you have to press the  button of the "Charts" 
toolbar, accelerating keys of Alt + 1, the corresponding option of the Charts Setup 
window, or execute the "Charts — Bar Chart" menu command. 

•Candlesticks — the sequence of candlesticks. 

To enable a chart of this type, you have to press the  button of the "Charts" 
toolbar, accelerating keys of Alt + 2, the corresponding option of the Charts Setup 
window, or execute the "Charts — Candlesticks" menu command. 

•Line Chart — a broken line connecting the bar close prices. 

To enable a chart of this type, you have to press the  button of the "Charts" 
toolbar, accelerating keys of Alt + 3, the corresponding option of the Charts Setup 
window, or execute the "Charts — Line Chart" menu command. 

 

•Saving 
The client terminal allows you to save historical data of the active chart as a text file in 
formats of "CSV", "PRN", and "HTM". 
To save them in one of these ways, you have to execute the "File— Save As" menu 
command or press accelerating keys of Ctrl + S. The chart can also be saved as a 
picture in BMP or GIF format. To do so, you have to execute the "File—Save As 
Picture..." menu command. The same actions can be performed with the chart context 
menu command of the same name. 

 

•Print 
To print the active chart in colour, you have to flag "Color print" in the chart settings, 
then execute the "File — Print..." menu command, the chart context menu command of 

the same name, press the  button of the "Standard" toolbar or accelerating keys of 
Ctrl+P. If  "Color Print" is disabled, or there is no colour printer available, the chart will 
be printed in black and white. 

 

•Full Screen 
Execution of the "View — Full Screen" menu command or pressing of F11 will switch 
the chart to the full screen mode. Only chart windows, main menu and chart switching 
bar will remain in the display. One can return to the initial mode using the same 
command. 

 

•Attaching of MQL4 Programs 
Before MQL4 starts to execute, it must be attached to the chart. To do so, you have to 
select the desired MQL4 program in the "Navigator" window and double-click on it or 
execute the "Attach to a chart" command of the context menu. The "Drag'n'Drop" 
technique can be used as well. 

 

 

http://www.metatrader4.com/en/trading-platform/help/analytics/tech_indicators
http://www.metatrader4.com/en/trading-platform/help/analytics/objects_control/line_studies
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_charts
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_charts
http://www.metatrader4.com/en/trading-platform/help/overview/fast_nav#accelerators
http://www.metatrader4.com/en/trading-platform/help/chart_management/charts_setup#common
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_charts
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_charts
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_charts
http://www.metatrader4.com/en/trading-platform/help/overview/fast_nav#accelerators
http://www.metatrader4.com/en/trading-platform/help/chart_management/charts_setup#common
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_charts
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_charts
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_charts
http://www.metatrader4.com/en/trading-platform/help/overview/fast_nav#accelerators
http://www.metatrader4.com/en/trading-platform/help/chart_management/charts_setup#common
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_charts
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_file
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_file
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_file
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_file
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_standard
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_view
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu
http://www.metatrader4.com/en/trading-platform/help/overview/navigator
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•Working with Indicators 
An indicator is a mathematical manipulation with price and/or volume of a security in 
order to forecast future price changes. Decisions about how and when to open or close 
a position are made on basis of signals from technical indicators. Indicators can be 
imposed onto a chart by the "Insert — Indicators" menu command or those of the 

indicators managing sub-menu that can be opened by pressing of the  button of the 
"Charts" toolbar. The "Drag'n'Drop" technique allows you to impose indicators from the 
"Navigator" window onto any open window as well. The list of indicators imposed onto 
the chart can be viewed in the "Data Window" by executing the "Charts — Indicators 
List" menu command, the chart context menu command of the same name, or by 
pressing accelerating keys of Ctrl+I. 
More details about working with technical indicators can be found in the section of the 
same name. 

 

•Working with Objects 
To analyze the market, one can impose various graphical objects onto the chart. To do 
so, you have to use the "Insert" menu command or buttons of the "Line Studies" toolbar. 
Line studies, geometrical shapes, signs, and texts are grouped in the menu. More 
details can be found in the "Graphical Objects" section. 

 

•Period Change 
The client terminal allows you to use nine different data periods, from a minute to a 
month. This variety of periods is necessary for analyzing the market with technical 
indicators and line studies. 

The desired period of the chart can be chosen with help of the "Period" toolbar, the 
button of the "Charts" toolbar, the "Charts — Period" menu, or by executing the chart 
context menu command. 

 

•Zooming 
Charts can be zoomed horizontally, increasing or decreasing thereby the amount of 
bars shown in the screen simultaneously. 

To do so, one can use the buttons of /  of the "Charts" toolbar, keys of "+"/"-", the 
commands of "Zoom In"/"Zoom Out" of the chart context menu and of the "Charts" 
menu. 
To zoom out a chart vertically, one can hold any point of the vertical axis with the left 
mouse button and move it down. Double click on the vertical axis or press "5" in the 
keypad to restore the scale. 
  
The chart can also be zoomed precisely by defining the upper and lower borders in the 
Charts Setup window with the "Scale fix" option. The "Scale fix One to One" option of 
the same window allows you to set the "one-to-one", i.e., one pip of vertical axis will 
correspond with one bar of the horizontal one. 

 

 

 

 

 

 

 

 

http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_insert
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_charts
http://www.metatrader4.com/en/trading-platform/help/overview/navigator
http://www.metatrader4.com/en/trading-platform/help/overview/data_window
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_charts
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_charts
http://www.metatrader4.com/en/trading-platform/help/analytics/tech_indicators
http://www.metatrader4.com/en/trading-platform/help/analytics/tech_indicators
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_insert
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_line_studies
http://www.metatrader4.com/en/trading-platform/help/analytics/objects_control/line_studies
http://www.metatrader4.com/en/trading-platform/help/analytics/objects_control
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_periodicity
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_charts
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_charts
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_charts
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_charts
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_charts
http://www.metatrader4.com/en/trading-platform/help/chart_management/charts_setup#common
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•Scrolling, Auto Scrolling, and Shifting of the Chart 
Scrolling is moving of price data to the right/left in the chart that can be performed by 
the cursor keys of the keyboard. The chart can also be scrolled with F12 (the "Step by 
Step" mode — scrolling the chart by one bar to the left) or Shift+F12 (scrolling the chart 
by one bar to the right), or with the mouse: one moves the cursor to the right/left when 
holding the left mouse button pressed on any point of the chart. Using the fast 
navigation box, you can show the necessary area of the chart having specified the date 
and time. If the chart has been scrolled to the area where there is no price data, the 
missing bars will be downloaded automatically. 
If the chart scale has been fixed, it can be scrolled vertically, as well. To do so, you 
have to move the mouse up/down while holding the slider on the vertical scale. To get 
the chart back into the visible range, you have to press "5" in the keypad or double-click 
in the area of the chart price scale. 
  
Auto scroll is intended for users to have the latest bars before their eyes constantly. If 
this option is enabled, the chart will be automatically scrolled to its end part. This 

function can be enabled by pressing of the button of the "Charts" toolbar or by the 
"Charts — Auto Scroll" menu command. 
  
The "Chart Shift" option shifts the latest bar from the right screen border to the chart 
shift mark. The chart shift mark (a gray triangle in the upper part of the window) can be 
moved horizontally with the mouse within 10 to 50% of the window size. The chart shift 

can be enabled by the button of the "Charts" toolbar or by the "Charts — Chart Shift" 
menu command. 

 

•Chart Positioning 
Normally, the chart datum point is located in the left part of the window. The specific 
time bar is anchored to it so it can be moved through scrolling or with the use of the fast 
navigation box. When a timeframe is changed, there will be an attempt to calculate the 
new anchoring bar corresponding with that of the previously used timeframe, i.e., the 
timeframe that is the nearest to this given point will be shown on the left side of the 
window. The datum point (a gray triangle at the lower border of the chart) can be moved 
within the chart window using the mouse. It appears only if the "Auto Scroll" is disabled. 
This mechanism is convenient when analyzing a certain period of time for different 
timeframes. 

 

Attention: Positioning does not work if the "Auto Scroll" option is enabled. 

 

•Working with Templates 
Templates refer to the chart window parameters stored in the memory. The following 
parameters are saved in a template: chart type, period, scale, all settings of line studies, 
technical and custom indicators, and experts. Templates allow you to unify the 
appearance of many charts easily and fast. 
The menu that manages templates can be called by the "Charts — Template" menu 

command, the chart context menu command of the same name and the button of 
the "Charts" toolbar. The "Save Template..." menu command allows you to store a new 
template, and that of "Remove Template" allows you to delete an existing one. 
More details can be found in the "Templates and Profiles" section. 

 

http://www.metatrader4.com/en/trading-platform/help/overview/fast_nav#fast_nav
http://www.metatrader4.com/en/trading-platform/help/overview/fast_nav#fast_nav
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_charts
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_charts
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_charts
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_charts
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_charts
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_charts
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_charts
http://www.metatrader4.com/en/trading-platform/help/chart_management/templates
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•Working with Profiles 
Profiles present a convenient way of working with chart groups. At the opening of a 
profile, each chart with all its settings will be found in the same condition as when the 
profile was stored. 
The menu that manages profiles can be opened by the "File — Profiles" menu 

command, by pressing of the button of the "Standard" toolbar, or by clicking with 
the mouse in the status bar containing the name of the current profile. 
More details can be found in the "Templates and Profiles" section. 

•Data Updating 
Data must be updated if any errors or "holes" occur in the price chart. In order to update 
the price data, you have to execute the "Charts — Refresh" menu command or the 
chart context menu command of the same name. After all these actions have been 
performed, the missing bars will be downloaded from the server automatically and 
drawn in the chart. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_file
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_standard
http://www.metatrader4.com/en/trading-platform/help/chart_management/templates
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_charts
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TRADING WITH MT4 PLATFORM 
 
The fundamental and simple rule of profitable trading in the financial markets is to buy 
cheaper and sell dearer. Thus, trading activities in the financial markets boil down to the 
successive operations performed to sell or buy securities. To do so, you have to open, 
modify, and close trade positions. Trade position is a market commitment (order) to the 
number of bought or sold contracts for which no set-off transactions have been made. Trading 
in the terminal is implemented through trade positions. 
 

Order Types 

The client terminal allows you to prepare requests to UOBKH for execution of trading 
operations. Moreover, the terminal allows you to manage open positions. For these purposes, 
several types of trading orders are used. An order is a client's commitment to UOBKH to 
perform a trade operation. The following orders are used in the terminal: Market order, 
Pending order, Stop Loss and Take Profit. 

  

Market Order 
Market order is a commitment to UOBKH to buy or sell a security at the current price. 
Execution of this order results in the opening of a trade position. Securities are bought at 
ASK price and sold at BID price. Stop Loss and Take Profit orders (described below) can 
be attached to a market order. Execution mode of market orders depends on the security 
traded. 

 

Pending Order 
A pending order is the client's commitment to UOBKH to buy or sell a security at a pre-
defined price in the future. This type of orders is used for opening of a trade position 
provided the future quotes reach the pre-defined level. There are four types of pending 
orders available in the terminal: 

 Buy Limit — buy provided the future "ASK" price is equal to the pre-defined value. 
The current price level is higher than the value of the placed order. Orders of this 
type are usually placed in anticipation that the security price, having fallen to a 
certain level, will increase; 

 Buy Stop — buy provided the future "ASK" price is equal to the pre-defined value. 
The current price level is lower than the value of the placed order. Orders of this 
type are usually placed in anticipation that the security price, having reached a 
certain level, will keep on increasing; 

 Sell Limit — sell provided the future "BID" price is equal to the pre-defined value. 
The current price level is lower than the value of the placed order. Orders of this 
type are usually placed in anticipation that the security price, having increased to a 
certain level, will fall; 

 Sell Stop — sell provided the future "BID" price is equal to the pre-defined value. 
The current price level is higher than the value of the placed order. Orders of this 
type are usually placed in anticipation that the security price, having reached a 
certain level, will keep on falling. 

 

http://www.metatrader4.com/en/trading-platform/help/positions/orders#market
http://www.metatrader4.com/en/trading-platform/help/positions/orders#pending
http://www.metatrader4.com/en/trading-platform/help/positions/orders#stop_loss
http://www.metatrader4.com/en/trading-platform/help/positions/orders#take_profit
http://www.metatrader4.com/en/trading-platform/help/positions/execution
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Orders of Stop Loss and Take Profit can be attached to a pending order. After a pending 
order has triggered, its Stop Loss and Take Profit levels will be attached to the open position 
automatically. 

Stop Loss 
This order is used for minimizing of losses if the security price has started to move in an 
unprofitable direction. If the security price reaches this level, the position will be closed 
automatically. Such orders are always connected to an open position or a pending order. 
UOBKH can only place them together with a market order or a pending order. The terminal 
checks long positions with BID price for meeting of this order provision (the order is always 
set below the current BID price), and it performs a similar check with ASK price for short 
positions (the order is always set above the current ASK price). 
To automate Stop Loss order following the price, one can use Trailing Stop. 

 

Take Profit 
The Take Profit order is intended for realising profits when the security price has reached a 
certain level. Execution of this order results in closing of the position. It is always 
connected to an open position or a pending order. The order can only be requested 
together with a market order or a pending order. The terminal checks long positions with 
BID price for meeting of this order provisions (the order is always set above the current 
BID price), and it performs a similar check with ASK price for short positions (the order is 
always set below the current ASK price). 
 
 

http://www.metatrader4.com/en/trading-platform/help/positions/trailing
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Trailing Stop 
 

Stop Loss is intended for the reduction of losses where the symbol price moves in an 
unprofitable direction. If the position becomes profitable, Stop Loss can be manually shifted to 
a break-even level. To automate this process, Trailing Stop was created. This tool is 
especially useful when the price changes strongly in the same direction or when it is 
impossible to watch the market continuously for some reason. 

 

Trailing Stop is always attached to an open position and works in the client terminal, not at the 
server like Stop Loss, for example. To set the trailing stop, you have to execute the open 
position context menu command of the same name in the "Terminal" window. Then, you have 
to select the desired value of distance between the Stop Loss level and the current price in 
the list opened. Only one trailing stop can be set for each open position. 

After the above actions have been performed, when new quotes are loaded, the terminal 
checks whether the open position is profitable. As soon as profit in points becomes equal to 
or higher than the specified level, a command to place the Stop Loss order will be given 
automatically. The order level is set at the specified distance from the current price. 
Furthermore, if the price changes in the more profitable direction, trailing stop will cause the 
Stop Loss level to follow the price automatically, but if profitability of the position falls, the 
order will not be modified anymore. Thus, the profit of the trade position is fixed automatically. 
After each automatic Stop Loss order modification, a record will be made in the terminal 
journal. 

Trailing Stop can be disabled by setting "None" in the managing menu. And trailing stops of 
all open positions and pending orders will be disabled if the "Delete All" command of the 
same menu has been executed. 

Trailing Stops are handled only on the client’s PC, and so will not be visible to UOBKH. The 
client must have MT4 open and connected for the Trailing Stop to work. If MT4 is closed or 
disconnected, the Trailing Stop will convert to a normal Stop Loss at its last set level.  
 

 
 
 

http://www.metatrader4.com/en/trading-platform/help/positions/orders
http://www.metatrader4.com/en/trading-platform/help/overview/terminal/terminal_trade
http://www.metatrader4.com/en/trading-platform/help/positions/orders
http://www.metatrader4.com/en/trading-platform/help/positions/positions_control/positions_modify
http://www.metatrader4.com/en/trading-platform/help/overview/terminal/terminal_journal
http://www.metatrader4.com/en/trading-platform/help/overview/terminal/terminal_journal
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Opening a Trade 
 
MT4 uses the same order window for all trades, whether that be opening or closing a trade, 
or placing an order to open.  
 
There are multiple ways to bring up the order window in MT4: 
 
 Right click on a chart, click Trading > New Order 
 Click the +New Order button on the toolbar 
 Double-click a symbol or price in the Market Watch screen  
 Right-click on the Trade tab in the Terminal 
 Open Tools menu > New Order 

Opening of a position, or entering the market, is the first buying or selling of a certain amount 
of the security traded. A position can be opened either by execution of a market order or by 
automatic triggering of a pending order. 

Market Order 

To open a position using a market order, you have to execute the "Tools — New Order" menu 

command, press the  button of the "Standard" toolbar, press F9, or double-click on the 
symbol name in the "Market Watch" window. One can also execute the "New Order" context 
menu command of the windows of "Market Watch" and "Terminal — Trade". The "Order" 
window used for managing trade positions will open.  

 

When opening a position, you have to: 

•Symbol — select a security symbol for which the position is to be opened; 

•Volume — specify the trade volume (amount of lots); 

•Stop Loss — set the Stop Loss level (optional); 

•Take Profit — set the Take Profit level (optional); 

 

Attention: Zero values of Stop Loss/Take Profit orders mean that the orders have not been 
placed at all. 

 

 

http://www.metatrader4.com/en/trading-platform/help/positions/orders#market
http://www.metatrader4.com/en/trading-platform/help/positions/orders#pending
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu/main_menu_tools
http://www.metatrader4.com/en/trading-platform/help/overview/toolbars/toolbars_standard
http://www.metatrader4.com/en/trading-platform/help/overview/market_watch
http://www.metatrader4.com/en/trading-platform/help/overview/market_watch
http://www.metatrader4.com/en/trading-platform/help/overview/terminal/terminal_trade
http://www.metatrader4.com/en/trading-platform/help/positions/orders
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•Comment — write a comment (optional). The comment length must not exceed 25 
characters. UOBKH may add a comment not above 6 characters long, or it can 
completely replace the existing one. After a position has been opened, the comment 
cannot be changed; 

•Type — the execution mode specified by UOBKH for the given symbol is displayed in 
this filed on default. You can also choose "Pending order" in the list here, which allows 
you to place a pending order. 

•Enable maximum deviation from quoted price — enable/disable the use of 
deviation. If UOBKH requotes the price of order execution, the deviation of the new 
price from the quote before will be calculated. If the deviation is below or equal to the 
specified parameter, the order will be executed at the new price without any additional 
notification. Otherwise, UOBKH will return new prices at which the order can be 
executed; 

•Maximum deviation — the value of maximum permissible deviation in pips. 

 

•Price deviation at placing of orders is used only in the instant execution mode. 
•The trade window displays current best Bid and Ask price (except for the Execution on 
Request mode). 

After all necessary data have been specified, you have to press the "Sell" or "Buy" button. 
The order for opening of a short or long position, respectively, will be sent to UOBKH. 

Once the order has been sent, the window will display the result of its execution — a 
successful trade operation or a reason why it has not been executed. If the "One click trading" 
option is enabled and the order has been successfully executed, the trading window is closed 
right away without displaying the execution result. 

Attention: If orders for a given symbol are executed at request, it is necessary to press the 
"Request" button to receive quotes first. Quotes offered after requesting will be active for just 
a few seconds. If no decision is made within these seconds, "Sell" and "Buy" buttons will be 
locked again. 

If the Stop Loss or Take Profit level is too close to the current price at opening of a position, 
the message of "Invalid S/L or T/P" will appear. It is necessary to shift levels from the current 
price and re-request for placing of the order. A trade position will be opened after UOBKH has 
made a trade and set Stop Loss and Take Profit. The status bar of the opened position will 
appear in the "Terminal — Trade" tab, and open price, Stop Loss and Take Profit levels will 
be shown in the chart (if the "Show trade levels" option is enabled). 

http://www.metatrader4.com/en/trading-platform/help/positions/execution
http://www.metatrader4.com/en/trading-platform/help/positions/positions_control/pending_orders_place
http://www.metatrader4.com/en/trading-platform/help/positions/execution
http://www.metatrader4.com/en/trading-platform/help/setup/setup_trade#one_click
http://www.metatrader4.com/en/trading-platform/help/positions/execution
http://www.metatrader4.com/en/trading-platform/help/positions/orders
http://www.metatrader4.com/en/trading-platform/help/positions/orders
http://www.metatrader4.com/en/trading-platform/help/overview/terminal/terminal_trade
http://www.metatrader4.com/en/trading-platform/help/positions/orders
http://www.metatrader4.com/en/trading-platform/help/setup/setup_charts
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Pending Orders 

To open a position with a pending order, you have to place it first as described in the "Placing 
of Pending Order" section. If the current prices meet its provisions, the pending order will be 
executed automatically, i.e., a new trade position will be opened. The status bar of the 
pending order will be deleted in the "Terminal — Trade" tab, and the newly opened position 
status bar will appear. If Stop Loss and Take Profit orders were attached to the pending order, 
they will be attached to the new position automatically. 

 
Amending an Open Position 
 
To amend an open position, right-click on it from the Trade tab in the Terminal, and select 
Modify or Delete Order.  
  
Here, you can enter a Stop Loss or Take Profit by entering the actual level; you can also 
use the quick-select buttons to calculate the level using a defined distance. To do this, choose 
the Level distance in the dropdown menu, then click the blue or red buttons to copy the 
calculated distance from the current level into the Take Profit or Stop Loss field.  
 

 
 

To change the Stop Loss or Take Profit values, you have to enter new values in the 
corresponding fields. To place the order in points from the current price, you have to set the 
desired value in the "Level" field and press the "Copy as" button. If values of these fields are 
zero, the minimum permissible deviation to use will be as set by UOBKH. 

 
Closing a Trade 
 
To close a trade 
 
1. From within the Trade tab of the Terminal, double-click the position you’d like to close. 
2. On the Order Window, click the yellow bar beneath the Sell/Buy buttons (it will show for 

example: “Close #323 buy 0.5 EURUSD by Market”).  
 

Please note: If the Sell/Buy buttons are clicked instead of the yellow bar, a new position will be 
opened. The will be confusing if you are used to IG’s close deal tickets which require users to 
press the Sell/Buy button to close.  

 

http://www.metatrader4.com/en/trading-platform/help/positions/positions_control/pending_orders_place
http://www.metatrader4.com/en/trading-platform/help/positions/positions_control/pending_orders_place
http://www.metatrader4.com/en/trading-platform/help/positions/orders
http://www.metatrader4.com/en/trading-platform/help/overview/terminal/terminal_trade
http://www.metatrader4.com/en/trading-platform/help/positions/orders#stop_loss
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Partially closing positions 
 
1. From within the Trade tab of the Terminal, double-click the position you’d like to close 
2. On the order Window, modify the Volume to the amount you’d like to close 
3. Click the yellow bar beneath the Sell/Buy buttons (it will show for example: “Close #326 

buy 0.20 EURUSD by Market”).  
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Placing Pending Orders  
 
An order to open is called a Pending Order in MT4. To place a Pending Order: 
 
1. Open the Order Window 
2. Enter the Volume (size) of the order 
3. Enter a contingent Stop Loss or Take Profit 
4. Choose Pending Order from the Type drop down menu  
5. Choose the Pending Order Type (But Limit, Sell Limit etc); MT4 does not choose the 

correct order automatically 
6. Enter the at price (trigger level) 
7. If you want the order to expire at a specific time/date, tick this Expiry option (otherwise it’s 

GTC)  
8. Click Place. 
 

 
 
 
Modifying Pending orders 
 

When working the market, you often need to modify or delete the placed pending order. To do 
so, you have to execute the pending order context menu command of "Modify or Delete 
Order" or double-click with the left mouse button on the pending order status bar in the 
"Terminal — Trade" window. The window for managing orders will open. The new price of the 
pending order trigger, new levels of Stop Loss and Take Profit, as well as expiry time of the 
order can be set in this window. After the order has been modified, you have to press the 
"Modify" button. 

Attention: Setting of zero values for Stop Loss and Take Profit equates to disabling of these 
orders. 

If the pending order has been successfully modified, the values of the corresponding fields in 
the "Terminal — Trade" window will be changed. If the "Show trade levels" option in the 
terminal settings has been enabled, the pending order levels and those of Stop Loss and 
Take Profit attached to it will be shifted correspondingly in the chart as well. 

 
 

http://www.metatrader4.com/en/trading-platform/help/positions/orders#pending
http://www.metatrader4.com/en/trading-platform/help/overview/terminal/terminal_trade
http://www.metatrader4.com/en/trading-platform/help/positions/orders
http://www.metatrader4.com/en/trading-platform/help/overview/terminal/terminal_trade
http://www.metatrader4.com/en/trading-platform/help/setup/setup_charts
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Deletion of Pending orders 
 
If the market situation has changed, there may be a necessity to delete a pending order. To 
do so, you have to execute the "Modify or Delete Order" pending order context menu 
command or double-click with the left mouse button on the status bar of the pending order in 
the "Terminal — Trade" window. The window for managing orders will open. To delete an 
order, the button of the same name must be pressed in it. Pending orders can also be deleted 
automatically at the time that has been given in the "Expiry" field. When a pending order has 
been deleted, the corresponding record will appear in the "Terminal — Account History" 
window. 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.metatrader4.com/en/trading-platform/help/overview/terminal/terminal_trade
http://www.metatrader4.com/en/trading-platform/help/overview/terminal/terminal_account_history
http://www.metatrader4.com/en/trading-platform/help/overview/terminal/terminal_account_history
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AUTOMATED TRADING  
 

To work the financial markets more effectively, you can develop your own successful system 
of trading. It is very difficult to act within a chosen system of trading in the manual mode due 
to significant influence of normal human emotions. Mechanical trading systems do not suffer 
from this disadvantage. 

The Client Terminal gives a large range of means for development and use of mechanical 
trading systems (MTS, experts, advisors). The development environment allows you to 
create, debug, and test expert advisors. Experts are able to not only alert you about 
recommended trading signals, but also undertake complete control over trading activities 
online. 

MetaQuotes Language 4, MetaEditor and strategy testing tools are built in the terminal. One 
can create the following using these means: 

 Expert Advisors — mechanical trading systems that allow complete automation 
of analytical and trading activities; 

 Custom Indicators — independently written technical indicators intended for 
analyzing of price changes; 

 Scripts — programs to be executed only once, on request. 
 

Expert Advisers 
 
Expert Advisers (EA’s) are automated trading systems that can be installed into the MT4 
platform. 
 
They are programs in the terminal that have been developed in MetaQuotes Language 4 
(MQL4) and used for automation of analytical and trading processes. They allow you to 
perform prompt technical analysis of price data and manage trading activities on basis of 
signals received. The entire routine work of technical analysis and trading can be given to 
experts. An expert can perform analytical and trading operations for any symbol or period 
independent of whether the corresponding chart was opened or not. 
 

EA’s are run on the client’s PC. They are not calculated or run on our MT4 server. The client’s PC 
must be left on, with MT4 open and connected for the EA to work.  

 
EA’s cannot be managed using the MetaTrader mobile apps.  
 
 

http://www.metatrader4.com/en/trading-platform/help/autotrading/mql4
http://www.metatrader4.com/en/trading-platform/help/autotrading/metaeditor
http://www.metatrader4.com/en/trading-platform/help/overview/strategy_tester
http://www.metatrader4.com/en/trading-platform/help/autotrading/experts
http://www.metatrader4.com/en/trading-platform/help/autotrading/custom_indicators
http://www.metatrader4.com/en/trading-platform/help/analytics/tech_indicators
http://www.metatrader4.com/en/trading-platform/help/autotrading/scripts
http://www.metatrader4.com/en/trading-platform/help/autotrading/mql4
http://www.metatrader4.com/en/trading-platform/help/autotrading/mql4
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Setting up EA’s 

Before using experts, you have to set them up first. Working parameters common for all 
experts are defined in the client terminal settings window. This window can be opened by the 
"Tools — Options" menu command or by pressing of accelerating keys of Ctrl+O. 

 

To set up expert parameters, you have to select the "Expert Advisors" tab. The following 
settings are available in it: 

 Allow automated trading — this option allows you to enable or disable the 
performance of trade operations by Expert Advisors and scripts. If it is disabled, 
scripts and Expert Advisors will work, but they will not be able to trade. This 
limitation can be useful for testing the analytical capacity of an Expert Advisor in 
the real-time mode (not to be confused with testing of Expert Advisors on historical 

data). Automated trading can also be allowed or disabled using the 
button on the toolbar. 

 

 Disable Auto Trading when the account has been changed — this option 
presents a protective mechanism disabling trading by Expert Advisors and scripts 
when the account is changed. It is useful, for example, when one changes a demo 
account for a real one. 

 

 Disable Auto Trading when the profile has been changed — a large amount of 
information about the current settings of all charts in the workspace is stored in 
profiles. Particularly, profiles contain information about Expert Advisors attached. 
Expert Advisors included into the profile will start working when a new tick loads. 
Having ticked this option, you can hinder trading by the Expert Advisors launching 
when the profile has been changed. 

 

 

 

http://www.metatrader4.com/en/trading-platform/help/setup/setup_experts
http://www.metatrader4.com/en/trading-platform/help/overview/main_menu
http://www.metatrader4.com/en/trading-platform/help/autotrading/experts
http://www.metatrader4.com/en/trading-platform/help/autotrading/scripts
http://www.metatrader4.com/en/trading-platform/help/chart_management/templates
http://www.metatrader4.com/en/trading-platform/help/autotrading/experts
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 Disable Auto Trading when the charts symbol or period has been changed — 
if this option is ticked, when the period or symbol of a chart is changed, the expert 
advisor which is attached to it will be automatically prohibited from performing 
trade operations. 

 

 Allow DLL imports 
To enlarge their functionality, expert advisors can use DLLs (dynamic-links 
libraries). If it is enabled, such libraries can be used without any limitations. If this 
option is disabled, no expert can use external DLLs. It is recommended to disable 
import when working with unknown experts. 

 

 Allow WebRequest for listed URL 
The WebRequest function in MQL4 is used for receiving and sending information 
to websites using GET and POST requests. To allow an MQL4 application to send 
such requests, enable this option and manually and explicitly specify the URLs of 
trusted websites. For security reasons, the option is disabled on default. 

 
Launching EA’s 

After general parameters have been set up, experts can be launched. To do so, it is enough 
just to attach the expert to the chart. The "Attach to a chart" command of the "Navigator — 
Expert Advisors" window context menu or double clicking with the left mouse button on the 
selected expert in the same window allows you to impose it onto the active chart. 

"Drag'n'Drop" technique allows you to impose the expert onto any chart. The window of the 
expert special settings will appear. 

 

http://www.metatrader4.com/en/trading-platform/help/autotrading/experts/experts_setup
http://www.metatrader4.com/en/trading-platform/help/overview/navigator
http://www.metatrader4.com/en/trading-platform/help/overview/navigator
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In its "Common" tab, the following are possible: 

Positions — select the direction of position opening: 

Long&Short — in both directions; 

Only Long — only for buying; 

Only Short — only for selling. 

Enable alerts — enable/disable the expert to alert; 

Disable alert once hit — disable alerts after the first alert has been given; 

Allow live trading — enable/disable live trading. Note that even if this option is enabled, 
the autotrading for the Expert Advisor may be disabled by the general settings of the 
terminal. 

Allow DLL imports — enable/disable imports of functions from DLL files; 

Allow import of external experts — enable/disable calling of functions from external 
experts; 

Allow modification of Signals settings — this option allows/prohibits an MQL4 
application to subscribe and unsubscribe from Signals as well as change the settings of 
signal copying. The functions for working with the base of Signals from an MQL4 
application allow you to performing your own analysis of the quality of signals, dynamically 
manage the subscription and adjust risks. More detailed information about the functions for 
managing the signals is provided in MQL4 Reference. 

External variables of the expert can be changed in the "Inputs" tab. 

 

These are variables of extern class. To save an input, you have to double-click with the left 
mouse button on its value and write a new one. You can change the value of each variable or 
download the set of inputs already saved (with the "Load" button). You can save the current 
set of external variables using the button of the same name. 

The "Reset" button returns all default settings. Parameters defined in the terminal settings are 
given in the "Common" tab. Parameters defined in the program source code are set as inputs. 
To attach the expert with the new parameters to a chart, you have to press "OK". To cancel 
the expert imposition, you have to press the button of the same name. 

http://www.metatrader4.com/en/trading-platform/help/setup/setup_experts#enable_ea
http://www.metatrader4.com/en/trading-platform/help/setup/setup_experts#enable_ea
http://www.metatrader4.com/en/trading-platform/help/signals/signal_subscriber
http://www.metatrader4.com/en/trading-platform/help/setup/settings_signals
http://www.metatrader4.com/en/trading-platform/help/setup/settings_signals
https://docs.mql4.com/signals
http://www.metatrader4.com/en/trading-platform/help/autotrading/experts/experts_setup
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Attention: Only attached experts can be set up individually. However, while executing, the 
window of the expert properties cannot be opened. This can be done only during intervals 
between calls of the start function. The expert will not be launched until its Properties window 
is closed. If the expert inputs were changed, the expert will be re-initialized with its new inputs 
at the pressing of "OK". 

After an expert has been set up, it will be initialized and, as soon as a new tick loads, will be 
executed. The expert is attached if its name and a smiley can be seen in the upper right 
corner of the chart. If live trading is disabled in the expert settings, an L will appear instead of 
the smiley. A dagger (û) means that all experts are disabled. 

Attention: Only one expert can be attached to a chart. If another expert is imposed, the 
previous one will be deleted from the chart. 

 
Shutting down EA’s 
 

To shut down an expert, you have to remove it from the chart. The expert must have been de-
initialized before it is shut down. To remove an expert from the chart, you have to execute the 
chart context menu "Expert Advisors — Delete" command or attach another expert to the 
same chart. The expert can also be removed from the chart at profile or template change. 

Attention: 

•during client terminal shutdown, all experts are shut down, too; 
•during chart closing, the expert attached to this chart will be shut down; 
•during imposition of another expert, the previous one will be removed after confirmation; 
•deletion of the expert from the "Navigator" window does not shut down the expert of the 
same name imposed on the chart; 
•disabling of experts in the client terminal settings does not provide complete disabling of 
experts. This option stops launching of the start function of each expert, but the initialised 
experts will continue to execute. 

 

http://www.metatrader4.com/en/trading-platform/help/autotrading/experts/experts_setup
http://www.metatrader4.com/en/trading-platform/help/chart_management/charts_control
http://www.metatrader4.com/en/trading-platform/help/chart_management/templates
http://www.metatrader4.com/en/trading-platform/help/overview/navigator
http://www.metatrader4.com/en/trading-platform/help/setup/setup_experts


UTRADE FX – MT4 USER GUIDE 

 

46 

Custom Indicators 
 
A custom indicator is a program independently developed in MetaQuotes Language 4 by the 
user and functioning as a technical indicator. A technical indicator is a mathematical 
transformation of security price and/or volume in order to forecast future price changes. The 
use of indicators allows you to answer the question about whether the current trend will 
remain the same and where it will turn. Indicators are intended for relative simplification of the 
complicated process of trading decision making. Algorithms of indicators are also used for 
development of trading tactics and expert advisors. 
 
Custom indicators can be downloaded the same way as EA’s, and can also be very complex. 
You can click and drag them onto a chart via the Navigator panel to launch them 
 
 

Scripts 
 

A script is a program written in MetaQuotes Language 4 (MQL4) and intended for a singular 
performance of any action. A script can fulfil both analytical and trading functions. Unlike 
experts, scripts are executed on request, not by ticks. In other words, where an expert works 
almost continuously, a script, having completed the function once, stops functioning by itself. 

Working with scripts entails: 

Creation of a Script 
The built-in "MetaEditor" is used to create and compile a script. It is a constituent of the 
client terminal and represents a convenient development environment of MQL4 programs. 

 

Script Setup 
You have to set up scripts first before using them. Working parameters common for all 
scripts are defined in the client terminal setup window. Every script has its own settings as 
well. 

 

Launching of a Script 
To launch a script, you have to attach it to the chart. The script algorithm will be launched 
immediately after that. 

 

Deletion of a Script 
The script completes its work after it has been deleted from the chart. 
 

http://www.metatrader4.com/en/trading-platform/help/autotrading/mql4
http://www.metatrader4.com/en/trading-platform/help/autotrading/mql4
http://www.metatrader4.com/en/trading-platform/help/autotrading/scripts/scripts_create
http://www.metatrader4.com/en/trading-platform/help/autotrading/metaeditor
http://www.metatrader4.com/en/trading-platform/help/autotrading/scripts/scripts_create
http://www.metatrader4.com/en/trading-platform/help/setup/setup_experts
http://www.metatrader4.com/en/trading-platform/help/autotrading/scripts/scripts_create
http://www.metatrader4.com/en/trading-platform/help/autotrading/scripts/scripts_create

